# CONTENTS

## About Sanako Study

- Study applications ................................................................. 3
- Sanako Study Tutor application ............................................. 3
- Sanako Study Student application ......................................... 3
- Sanako Study Server ............................................................. 3
- Study licenses ........................................................................ 4
- Study classrooms .................................................................... 4

## Requirements

- As per the requirements for the Microsoft® Windows® 7, Windows 8, or Windows 10 operating system ................................................................. 5
- Network Requirements ............................................................... 6
- Firewall settings ...................................................................... 7
- Notes on disk space .................................................................. 7

## Installation

- Software components .............................................................. 8
- Recommended installation order ............................................... 8
- Installation Instructions ........................................................... 9
  - Study Server software installation ....................................... 9
  - Study Tutor software installation .................................... 13
  - Study Student software installation ................................15
- After installation – Registering and binding tokens to account .............. 18

## Starting Study

- Selecting Tutor and Classroom ............................................. 21
- Adding students and creating default class .............................. 22
  - Moving and arranging student icons .................................. 23
  - Removing students ............................................................ 24
- Starting Study Student ........................................................... 24

## Audio Settings

- Testing sound hardware compatibility .................................. 25
- Sound device selection .......................................................... 25
- Setting sound device volumes .............................................. 26
- How to copy student audio settings ..................................... 27
- Using a media player as source .............................................. 28
- Setting data properties for saved audio files ......................... 29

## Configuring folders

## Tutor accounts and class files

- Adding a new tutor ............................................................... 32
- Disabling Tutor login ............................................................. 33
- Class files ............................................................................... 34
- Tutor specific settings ......................................................... 36

## General settings


ABOUT SANAKO STUDY

STUDY APPLICATIONS

SANAKO STUDY TUTOR APPLICATION
Teachers use the Study Tutor application, which is the main interface to the Study system. The Tutor application allows teachers to instruct with the Study system and to control the classroom computers.

SANAKO STUDY STUDENT APPLICATION
The Study Student application is installed onto all student computers. Study Student connects to Study Server at system startup and runs in the background listening for commands from Study Tutor. Students can open the student interface to work independently, however, teachers are able to control student computers, regardless of whether the Student application is visible on student screens or not.

SANAKO STUDY SERVER
The Study Server application is the information center of the Sanako Study system and both the Tutor and Student components automatically connect to it. All system data is passed through Study Server and it allows communication between the Tutor and Student components.

We recommend using classroom specific server computers, commonly the teacher computer in each class, with individual classroom names.

However, you may also use a shared license server for multiple classrooms. Please note that in this case the shared license server must be running in order to use any of the classrooms.
STUDY LICENSES

Instead of a printed product license, Sanako Study customers receive a license activation token by email. The token is entered during Study Server software installation to activate the software license. However, the activation process requires that you have an active Internet connection.

We also recommend all customers to register and create a user account on the Sanako registration portal in order to ensure that they will receive all product updates according to their software maintenance agreement. The registration can be done anytime. Once you have completed the registration process, you will receive your user account information by email. The address for the registration portal is:


In case the computer where you are installing Study Server software does not have an Internet connection, you may complete an alternative offline activation process in order to finalize your installation.

STUDY CLASSROOMS

Sanako Study uses virtual ‘classrooms’ to bring together both teacher and student computers into the same learning space. Each teacher and student computer is assigned a ‘classroom name’ during installation. When teachers begin a learning session, they will get to select which student computers to include from all the computers in their ‘classroom’.
REQUIREMENTS

AS PER THE REQUIREMENTS FOR THE MICROSOFT® WINDOWS® 7, WINDOWS 8, OR WINDOWS 10 OPERATING SYSTEM

- Microsoft® Windows® 7, Windows 8, or Windows 10 operating system
- Microsoft .NET Framework® 4.0 Full
- 1.5 GHz processor
- 1 GB of system memory, 2 GB recommended for Tutor PC
- 100 MB of free disk space for installation *
- 1024*768 display resolution with 16-bit colors
- AC97 or HDA compatible sound card
- Network Adapter, TCP/IP support required
- PC Headset – recommended Sanako models to ensure high quality audio
- Internet access during Server component installation**

*) The amount of free disk space required during the use of Study 1200 varies primarily according to the use of the recording functionality - longer recording times require more disk space.

**) If there is no Internet connection on the Server computer, you may perform an offline activation process. Instructions for offline activation can be found later in this guide.

Note: It is mandatory for proper operation of the lab that hibernation and switch user NOT be used under any circumstances. If they are then the system must be rebooted to restore full functionality.

Note: Actual requirements may vary based on your system configuration. It is essential to make sure that the operating system runs smoothly on each computer where a Study Tutor or Student application will be installed.
Note: We recommend that you install all Windows updates for your operating system in order to ensure that Study will run properly.

Note: Study extension modules may have additional software and hardware requirements. Please ensure that your environment also meets the requirements of any modules that will be installed.

NETWORK REQUIREMENTS

The following requirements should be met by the network.

- Study uses Multicast transmission by default with Unicast an optional transmission mode. Multicast must be enabled in the network if multicast transmission is used.
- All computers must be in the same TCP/IP sub-net in order to allow multicast transfer of screen and audio to students.
- It is recommended that all workstations within a room are connected to the same network switch with support for multicast transmission.
- Student and teacher workstations need to be able to PING each other and the Study Server with TCP/IP packets.
- If the computers have multiple network adapters, the adapter used by Sanako Study must be bound first, because Windows operating systems send multicast data to the first adapter.
- In LAN minimum of 100Mbps speed or greater dedicated to each workstation. For Wi-Fi implementations, please refer to the Sanako Wi-Fi Deployment Guide found on the installation DVD for requirements and suitable wireless hardware.
- For optimum performance in file operations, we recommend using a file server for storing media files and collected student recordings. However, the teacher computer may be used for file operations if a separate file server is not available.
  - Teacher and students should have unrestricted access to the server.
  - Schools may use an existing server with Linux, Windows NT or Windows Server operating system.
  - A NAS (Network Attached Storage) server may also be used.
FIREWALL SETTINGS

Sanako Study adds required Windows firewall exceptions automatically during installation.

If a non-Windows firewall is used please verify that the following programs have been added to the firewall exceptions list.

- Tutor.exe (Tutor computer)
- Student.exe (Student computers)
- StudyServer.exe (on computer with Study Server software)

The default TCP ports used by Sanako are:

- Port 5060 for audio packets
- Port 15525 for screen packets
- Port 15535 for remote control data
- Ports 6310, 6311 and 6312 for Study Server operations

NOTES ON DISK SPACE

The amount of hard disk space required for the storage of digitized files depends on how much material will be made available to the students at any one time and how much work the students are likely to save to their own area. Disk quota sizes usually vary between 20 and 50MB per student. However, students using Study 1200 typically require a disk quota of 100MB minimum to allow them to save work during class for self-study reinforcement.

A typical MP3 audio file size (default setting in Study 1200) is approximately 1MB per minute.

Therefore, a typical 160GB hard disk drive would allow for the saving of approximately 2600 hours of audio.

In order to ensure that this information can be delivered to all the student desktops simultaneously (i.e. smooth video and audio playback) Sanako strongly recommends the use of hardware RAID controllers on the server or the use of Network Attached Storage (NAS) devices.

Sanako also recommends that you take regular data back-ups. The use of a CD/DVD writer is also recommended to save student oral recordings and/or source material that are infrequently used. When this material is required it can be copied to the server from the CD archive.
INSTALLATION

At the time of installation, the installer needs to have Local Administrator user rights. Please note that in some configurations, Domain Administrator rights are not enough to install applications.

Computers where Study is installed must have a suitable way to access Sanako installation media. This can be e.g. a DVD-drive, a USB port which supports USB memory keys or access to a network location where Study installation files are placed.

SOFTWARE COMPONENTS

The following software components are always installed in all Study installations:

- **Sanako Study Server software**
  Installed on either teacher or server computer

- **Sanako Study Tutor software**
  Installed on teacher computer

- **Sanako Study Student software**
  Installed on student computers

We recommend using classroom specific server computers, commonly the teacher computer in each class, with individual classroom names.

However, you may also use a shared license server for multiple classrooms. Please note that in this case the shared license server must be running in order to use any of the classrooms.

RECOMMENDED INSTALLATION ORDER

We recommend that the different components are installed in the following order:

1. Sanako Study Server software (on tutor or server computer)
2. Sanako Study Tutor software (on tutor computer)
3. Sanako Study Student software (on student computers)

INSTALLATION INSTRUCTIONS

STUDY SERVER SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study Server software.

**Note**: Study Server installation requires an Internet connection. If the server computer does not have an Internet connection, you may complete an alternative offline activation procedure. Instructions for this can be found towards the end of this guide.

1. Select Sanako Study Server software in the Installation CD menu to start the installation program.

2. Exit any other programs you have open and click **Next** to continue with the installation.

![Welcome to Sanako Study Communication Services 8.0 Installation Wizard](image-url)
3. Accept the license agreement and click Next.

4. Select a suitable installation folder and click Next.

5. You can now go back and change any of your selections or click Install to start the installation.
6. The installation program will next ask you about the Study license server and classroom name.

**LICENSE SERVER**

If you only install one server for your Study system, select the 'This Study Server acts also as license server' option.

If you have multiple server applications in your institution, select the 'This Study Server will ask for licenses from other Study Server' option and enter the name of the computer that has been selected as the license server.

**CLASSROOM NAME**

If you have only one Study classroom in your school you may use the default classroom name. If you have multiple Study classrooms then define a classroom name for the classroom in question.

**Note:** Classroom does not refer to a physical space here, but instead to a collection of computers in the school network that may be used in the same Study learning session.
7. Next, a license management window appears. Click **Activate Token** and then enter your token information and click **Activate License**.

8. You have now successfully activated your software. Store the installation ID for future use. Click **OK** to continue.

9. Once the installation program has finished, click **Finish** to exit the installation program.
STUDY TUTOR SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study Tutor software

1. Select **Sanako Study Tutor Software** in the Installation CD menu to start the installation program.

2. Exit any other programs you have open and click **Next** to continue with the installation.

3. Accept the license agreement and click **Next**.
4. Select a suitable installation folder and click **Next**.

![](image1)

5. You can now go back and change any of your selections or click **Install** to start the installation.

![](image2)

6. The installation program will next ask you to select a classroom name.

![](image3)

If you have only **one Study classroom** in your school you may use the default classroom name. If you have **multiple Study classrooms** then define a classroom name for the classroom in question.

**Note:** Classroom does not refer to a physical space here, but instead to a collection of computers in the school network that may be used in the same Study learning session.
7. Next, you will be asked to set your default sound devices. This can also be done after the installation. For more information on the selections, see Audio Settings later in this guide.

8. Once the installation program has finished, click Finish to exit the installation program.

STUDY STUDENT SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study Student Software.

1. Select Sanako Study Student Software in the Installation CD menu to start the installation program.
2. Exit any other programs you have open and click **Next** to continue with the installation.

3. Accept the license agreement and click **Next**.

4. Select a suitable installation folder and click **Next**.
5. You can now go back and change any of your selections or click **Install** to start the installation.

6. The installation program will next ask you to select a classroom name.

   ![Classroom name selection](image)

   If you have only **one Study classroom** in your school you may use the default classroom name. If you have **multiple Study classrooms** then define a classroom name for the classroom in question.

   **Note:** Classroom does not refer to a physical space here, but instead to a collection of computers in the school network that may be used in the same Study learning session.

7. Next, you will be asked to set your default sound devices. This can also be done after the installation. For more information on the selections, see **Audio**
8. Once the installation program has finished, click **Finish** to exit the installation program.

**AFTER INSTALLATION – REGISTERING AND BINDING TOKENS TO ACCOUNT**

After you have completed your Sanako Study installation, we recommend that you register your software. This ensures that you will receive all product updates according to your software maintenance agreement.

Open your Windows **Start** menu and select **All Programs** – **Sanako** – **Licenses**.
In the Licenses window, select your Study license and then click **Register**.

If you have a registered Sanako user account, enter your account details and click **Bind License**.

This completes the binding process and your token information has been saved to your user account.

If you do not have a Sanako registration account, you need to create one in order to register your software. Click **Get a registration account here!** to enter account creation. Provide registration information to the fields and click **Save** to send in your information.
You will receive your username and password to the E-mail address provided during registration and a link to the login page of the Sanako registration system. Click the link to confirm your registration. Logging in is not required at this point, but you can do so at any time to edit your information.

Next, enter your account details and click **Bind License**

This completes the binding process and your token information has been saved to your user account.
STARTING STUDY

After the installation, you are ready to start Study. To start Study Tutor, open the Windows Start menu (lower left corner on your screen) and select Programs > Sanako > Study > Tutor, or double-click the Study Tutor icon on the teacher computer desktop.

SELECTING TUTOR AND CLASSROOM

After defining audio devices, you will next be asked to select a Tutor account and a class file to open Study with. When you start Study for the first time, select Anonymous tutor and Empty class, since no teacher accounts or class files have been created yet. This will start you with an empty default classroom.

For instructions on how to create teacher accounts and class files, see Tutor accounts and class files later in this guide.
ADDING STUDENTS AND CREATING DEFAULT CLASS

When you start the Tutor application for the first time, the main window of Study opens without any student icons. You can now add students to the classroom and create a default class layout.

To add more student workstations to the current classroom:

1. Click on **Show Corridor** at the bottom of the Tutor screen.

2. This opens a dialog displaying all the student computers in the classroom that are switched on.

3. Select the students you want to add and click **Add to session A**, or if you want to assign them to specific sessions, click **Add selected students to session**...

4. The added students are now displayed on the classroom view.
The Study class view is a graphical layout of your class. Your students are displayed as student icons that reflect their current status.

5. To save the current classroom layout as the default class, open the **File** menu and then select **Class file** and **Save**.

**MOVING AND ARRANGING STUDENT ICONS**

You can rearrange the student icons on the layout to correspond with your actual classroom. Open the **Tools** menu and select **Admin – Move and align student icons**… to open a panel with commands for moving and arranging student icons.

To move a student icon, select **Move** and hold your mouse button down over the student icon.
To align student icons, select one of the alignment options, hold your mouse button down and drag the mouse pointer over the student icons that you want to align.

You can also move student icons at any time by holding down the Ctrl and Shift buttons on your keyboard and holding your left mouse button down over a student icon.

REMOVING STUDENTS

To move a student from the class back to the corridor, right-click a student icon and select Send to corridor. The student can then be selected to another class by another teacher.

To remove a student and the student icon from the class view, right-click a student icon and select Exclude from class (and layout). Once the student icon is removed, the classroom configuration can be saved as a new class.

STARTING STUDY STUDENT

To open the Study Student interface on a student computer, click the Windows Start menu and select Programs – Sanako – Study Student – Student. The teacher can also at any time display the Student applications on student workstations by clicking on the Student Applications button on the Tutor interface.

Even if the Study Student application is not open on the student screen, it is always running in the background listening to commands from Study Tutor when the workstation is on.
TESTING SOUND HARDWARE COMPATIBILITY

Sanako Study includes an inbuilt application for testing whether the sound hardware on a given computer is compatible with Study. To test your sound hardware compatibility, open the Tutor or Student Tools menu and select Sound Hardware Test Wizard.

SOUND DEVICE SELECTION

Sound devices are commonly set when Study is started for the first time.

However, you can edit Study sound device selections at any time by selecting Sound settings in the Tools menu of either the Tutor or Student application.

This opens the Sanako Sound Device Wizard in which you can assign Sound devices for each Study audio function.
When you are finished with the audio device selection, click **Save & Quit** to save your settings.

**SETTING SOUND DEVICE VOLUMES**

Study has an inbuilt audio testing procedure in **Sound Device Wizard** which allows you to identify and set default volume levels for Study functionalities.

To test and set default volume levels

1. **Click Start test**

2. **Follow the instructions on the screen to play sample audio, make test recordings and define the default volume levels for each audio device.**

The default audio levels will be saved into a file which can be deployed to all the computers in the classroom. This allows you to equalize the audio levels for an entire classroom without running the testing procedure separately for each computer.

**SETTING SOUND DEVICE VOLUMES FOR SANAKO HEADSET**

If you are using Sanako SLH07 USB headsets, Study has inbuilt default audio settings that you can easily apply. Simply click on ‘Set Sanako Headset defaults’ to employ
audio settings that have been preconfigured for use with a Sanako headset.

HOW TO COPY STUDENT AUDIO SETTINGS

Sanako Study allows you to automatically equalize all the student audio settings in a Study classroom, eliminating the need to configure each workstation individually. To do this you need to first carefully adjust the audio settings of one Study player application. These settings will then be copied to all the other player applications.

To copy student audio settings to other workstations, follow the instructions below.

1. Open the Tools menu in Study Tutor, select Admin and then Student settings.

2. In the Student settings window, you need to first select the source computer whose audio settings will be shared. Click on Select source workstation and
select the source computer in the drop-down list.

3. Next, check the workstations where you want to copy the audio settings. If the settings will be copied to the entire classroom, click ✔ to select all workstations.

4. Once you have selected the target workstations, click Copy settings, the workstation list on the left will indicate when the copying is ready.

5. When the settings have been copied to the desired workstations, click Close to exit the settings window.

USING A MEDIA PLAYER AS SOURCE

If a Media Player application is used as the media source in Study, ‘overlays’ need to be disabled in the media player.

To disable overlays in Windows Media Player, select More Options under Library. In the Options window, select the Performance tab and click Advanced under Video Acceleration. In the Video Acceleration Settings window unselect the Use overlays option.
SETTING DATA PROPERTIES FOR SAVED AUDIO FILES

To set data properties for saved student recordings, open the Student Tools menu and then select Settings.

![Settings dialog box]

- Language:
  - Arabic
  - Danish
  - German
  - English
  - Spanish
  - Swedish
  - Italian

- File save options:
  - Sample rate
  - Bits per sample
  - Channel

[OK] [Cancel]
CONFIGURING FOLDERS

Many Study functionalities require that you define a default file folder for them where functionality specific files are then stored. All these folders can be configured in Study Tutor Preferences. To edit default folders, open the Study Tools menu, select Preferences and then the Tutor tab.

It is recommended that all these folders are located in a separate file server, however, the Tutor’s class directory folder can also be located on the local teacher computer.
The table below provides information on the folders and their access rights:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Purpose Of The Folder</th>
<th>Teacher Access Required</th>
<th>Student Access Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutor's class directory</td>
<td>Storage area for teacher's class files</td>
<td>Read/Write/Modify</td>
<td>No Access Required</td>
</tr>
<tr>
<td>Student files collection</td>
<td>Collecting student recordings</td>
<td>Read/Modify</td>
<td>Hidden Write</td>
</tr>
<tr>
<td>folder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Playlist and content files</td>
<td>Sharing teaching content. Subfolders for sessions A,B,C,D,E,F and Tutor will be created under this folder</td>
<td>Read/Write/Modify</td>
<td>Read</td>
</tr>
<tr>
<td>folder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media files folder</td>
<td>Storage area for different media source files, which can be used during teaching activities</td>
<td>Read/Write/Modify</td>
<td>Read</td>
</tr>
<tr>
<td>Web policy files folder</td>
<td>Saving Web policy files, which are used during the Web browsing activity</td>
<td>Read/Write/Modify</td>
<td>No Access Required</td>
</tr>
<tr>
<td>Application list files</td>
<td>Storage area for lists of denied and allowed applications which are used in the Block applications function</td>
<td>Read/Write/Modify</td>
<td>No Access Required</td>
</tr>
<tr>
<td>folder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document files folder</td>
<td>Storage area for document files which are used during the reading practice activity</td>
<td>Read/Write/Modify</td>
<td>Read</td>
</tr>
<tr>
<td>Vocabulary files folder</td>
<td>Storage area for Vocabulary tests</td>
<td>Read/Write/Modify</td>
<td>No Access Required</td>
</tr>
<tr>
<td>Exam test files folder*</td>
<td>Storage area for exam files, which are used during the Exam activity</td>
<td>Read/Write/Modify</td>
<td>Read</td>
</tr>
<tr>
<td>Exam result files</td>
<td>Collecting exam result files from students during the Exam activity</td>
<td>Read/Modify</td>
<td>Hidden Write</td>
</tr>
<tr>
<td>collection folder*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*These folders are needed only if Sanako Study Examination Module has been installed
TUTOR ACCOUNTS AND CLASS FILES

The purpose of tutor accounts and class files is to allow each teacher to start the system with their own default settings and with a pre-set classroom layout for each different course, if needed.

Each teacher has a personal tutor configuration file with their preferences but can employ multiple class files. When teachers open the Study Tutor application they need to select their own tutor name and the class file that they want to use.

ADDING A NEW TUTOR

In order to add a new tutor to Study, open the Tools menu and then select Admin and Add/Remove Tutors…

You can now enter a new tutor name that will be available when logging into the Study Tutor application. To set the folder where the new tutor’s class files are saved, click on the Browse button.
After a new tutor has been added to the system, a tutor specific Tutor Configuration File (.TCF) is created automatically by the system.

When you have entered a tutor name and defined a folder for the tutor’s class files, click on **Save** and then exit the Study application. When the Study application is restarted, the new tutor name is available in the log in window.

**DISABLING TUTOR LOGIN**

If you do not want to use personal tutor accounts, you can disable tutor login. This means that Study will simply be opened with the default classroom layout and tutor settings every time.
To disable Tutor login, go to Tools > Preferences > Login tab and uncheck the Request Tutor login at start-up option.

CLASS FILES

Class files include the classroom layout, student names, sessions and default activities.

Each Tutor can own multiple personal class files (.CCF) and can select which class file they want to use when logging in.

Tutors can also manually open, save and remove class files by opening the File menu and selecting Class file.
CREATING A NEW CLASS FILE

To save the current classroom settings as a new class file, open the File menu and select Class file > Save.

This opens a window where you can name the class file and then save it. If you save the file as a Template Class File, the class file will be available for all tutors when they log in.

If changes have been made to the classroom settings during a lesson, Study will automatically ask you whether you want to save the changes to the current class file when the Tutor application is closed.

SAVE LOCATION FOR CLASS FILES (.CCF)

To set the location where the Class Files are saved, open the Tools menu and select Preferences and then the Tutor tab.
**TUTOR SPECIFIC SETTINGS**

Tutor configuration files contain the personal settings of each tutor, including:

- Tutor name
- Save folder for class files (.CCF)
- Interface language selection
- Session file folder
- Student file collection folder
- Program shortcuts for application launch
- Last used class file
- Auto scan interval
- Auto scan order
- Thumbnail size

Each tutor has their own Tutor configuration file (.TCF) which is created when a new tutor is added into Sanako Study.

Most Tutor specific settings are available under the **Tutor** tab in the Tutor application **Preferences**. To open the Preferences window, start the Tutor application and then open the **Tools** menu and select **Preferences**.
APPLICATION LANGUAGE

Determine the Tutor interface language. The default selection for the interface language is English. Additional interface languages can be selected in the drop down menu.

AUTOSCAN

Set the default time that each student screen is displayed during the autoscan function and select the order in which the student screens will be shown.

THUMBNAIL SIZE

Use the slider to determine the size of thumbnail images of student screens.

To view thumbnail images of student screens either in place of the student icons or in a separate window, click the Screen Control button and select either Thumbnails or Thumbnails in separate window.
Talking to students

- Talk
- PC control
- Screen control

Autostart
- Thumbnails
- Thumbnails in separate window

- Tutor screen to students
- Model screen to students

Messages
Chat
GENERAL SETTINGS

You can set general settings for different Study functions in the Settings tab of the Tutor Preferences window.
**ACTIVITY**

- **Activity**
  - Select whether to minimize the Tutor application when the Tutoring activity is started and the Tutor screen is transferred to students.

- **Available session activities**
  - Select which activities are displayed in the Activity selection list in the Tutor application. This allows you to configure the list so that only the activities that are actually used are visible.

**AUDIO**

- **Activity**
  - Stream Tutor media files
  - Stream student media file while monitoring
  - Monitor input line = StereoMix
  - Monitor input line = Microphone
  - Use Custom Settings for Voice Activity Detection (VAD)
  - Voice Activity Detection (VAD) on/off
  - VAD Sensitivity

**Stream Tutor media files** means that when a file is used as the audio source to students, the audio is sent as a VOIP stream instead of the students opening the file.

There are two different ways of monitoring student audio in Study:
If **Stream student media file while monitoring** is selected, the student audio is streamed to the teacher as a VOIP stream during monitoring. The teacher will hear the student’s microphone and any media file that the student may be listening to. 

**Note:** Student microphone cannot be monitored during an activity, if the media source is Tutor player, CD audio or an External source.

If **Monitor input line** is selected the mixer audio lines are monitored and you can choose what you’ll be able to hear when monitoring students. **Stereomix** allows you to hear whatever the student hears. **Microphone** means you will hear the student microphone during monitoring.

**Note:** Regardless of the selected option, if students are monitored while they are recording their voice, only the student voice can be heard.

**Voice Activity Detection** is used to identify when users are speaking into their microphone. Properly adjusting the sensitivity of Voice Activity Detection may help prevent unnecessary audio transmission and improve audio performance. If Voice Activity Detection is adjusted in the Tutor settings, the new setting is automatically employed in all student workstations in the Study classroom.

Check the **Use Custom Settings for Voice Activity Detection** option to override the operating system default setting and manually adjust **Voice Activity Detection sensitivity** and to switch **Voice Activity Detection On** or **Off**.

**Tutor Player** allows you to define the default teacher media player application.

### FILE DISTRIBUTION

**Always use file transfer** means that any files that are opened to students are always copied for them as local copies instead of file streaming. This includes using files as the media source and the functions in the file areas. Using file transfer allows you to use materials that are located outside student access, for example, files on network folders, including those mapped with UNC paths, or the teacher computer.
Checking the **Allow file transfer from local folders** option will allow the teacher to open files to students from any local folder, for example on the teacher computer. The students do not need access rights to the folder, since the launched file will be copied to the student computer instead of file streaming. This includes using files as the media source and the functions in the file areas. Please note that this feature does not allow file transfer from folders mapped with UNC paths.

**Default file type** allows you to select the default file format that is used for collected student recordings.

**INTERNET**

<table>
<thead>
<tr>
<th>File distribution and collection</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Internet</td>
</tr>
<tr>
<td>- Enable Internet blocking</td>
</tr>
<tr>
<td>- Disable programs</td>
</tr>
<tr>
<td>- explorer.exe</td>
</tr>
<tr>
<td>- firefox.exe</td>
</tr>
<tr>
<td>- opera.exe</td>
</tr>
<tr>
<td>- chrome.exe</td>
</tr>
<tr>
<td>- netscap.exe</td>
</tr>
<tr>
<td>- Block other browsers during Web activities</td>
</tr>
</tbody>
</table>

The Internet options allow you to block Internet ports and Web browsers.

**Enable internet blocking** allows the teacher to use the Disable Internet function in the Tutor application PC Control features to disable all Internet traffic on student computers.

**Block other browsers during Web activities** allows the Web browser applications opened by the teacher, but prevents students from opening any other browser applications.

**SCREEN TRANSFER**

<table>
<thead>
<tr>
<th>Screen transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Full screen view on student screen</td>
</tr>
<tr>
<td>- Topmost window on student screen</td>
</tr>
<tr>
<td>- Open 'On The Air' window expanded</td>
</tr>
</tbody>
</table>

The Screen Transfer settings apply when a Tutor or Student screen is shared to others.
TEXT-TO-SPEECH

Text-to-Speech (TTS) allows you to set default settings for created Text-to-Speech files.

- Select the **playback voice** for the created audio file. Multiple voices and languages are available from your local Sanako representative.
- Adjust the **playback speed**, slower speed may help students distinguish sounds.
- Select whether each sentence will be marked with a **bookmark** in the audio file. This may help students to navigate the material.
- Select whether the text will be displayed as **subtitles** during playback to help comprehension.

THUMBNAIL / SNAPSHOT

Set the default time for updating thumbnails and snapshots of student screens.

WLAN

Disabling screen transfer operations will deactivate all screen transfer features in Study. This is beneficial in wireless environments where using the screen transfer operations could slow the system down.
Network connection type allows you to define the type of network Study is used in. This helps the program configure itself for optimal performance.

Unicast allows you to select the transmission method for the Study system to correspond to your network environment. By default, Study uses Multicast transmission and the selection is unchecked. Selecting Unicast transmission can sometimes help in challenging environments as it provides more secure, although sometimes slower, delivery.

IDENTIFYING STUDENTS

DEFAULT STUDENT NAMES
You can choose a default option for naming students in the Study classroom view in Tutor Preferences in the Login tab.

All students that join a classroom are automatically named according to the selection made here. However, loading a saved class file will instead use the names saved in the class file.

IDENTIFYING STUDENT COMPUTERS
You can choose a default option for identifying individual student computers that join the Study classroom in Tutor Preferences in the Login tab.
There are two options for identifying student computers that will be added into a Study classroom.

- **Student PC name** (default option) will identify all computers with a different computer name as individual students and add a new student icon for each student computer. This is the recommended setting in all environments where students operate individual student computers.

- **Student User name** will add a student icon for each different student login name that enters the Study classroom. This setting is usually only used in settings where multiple students share a workstation.

**SYSTEM CONFIGURATION SETTINGS**

Sanako Study system configuration settings allow you to

- View available licenses
- Edit classroom selections
- Set password protection for the Tutor application
- Change your installation type

To access system configuration settings, open the Tools menu in Study Tutor and select Preferences. In the preferences window select the System tab, click the Change system configuration settings button and click OK.

This opens a Sanako Study configuration window where you can manage the above information.
LICENSE QUERY

Study asks you to enter your license information during the Study Server application installation. Depending on your license information, you can select which Study version to query from the Study Server.

CHANGING ACTIVE PRODUCT LICENSE

1. In the Sanako Study configuration window, select Product licensing and then choose which license to query from the server.

EDITING CLASSROOM NAMES AFTER INSTALLATION

The classroom that Study computers belong to is set during the installation. However, you can change the classroom affiliations of tutor and student applications after the installation.

To change the Tutor application classroom, select Classroom selection in the Sanako Study configuration.
window, and then click Change….

To change the Student application classroom, open Windows Explorer, go to the Program Files / Sanako / Study / Student folder and run the SetClassroom.exe application. Running SetClassroom.exe opens a dialog where you can select a new classroom in a drop-down menu.

PASSWORD PROTECTION FOR STUDY TUTOR

If needed, you may set a password for the Study Tutor application. Password protection is normally only used in instances where the same workstation is used both as a teacher and student computer. Most commonly this occurs in multipoint server environments (see ‘Installation type’ below)
To enable password protection for the Study Tutor application, select **Password protection**, check the **Password protected** option and then click **Change** to enter a new password. This password will then be requested every time the Tutor application is started.

**INSTALLATION TYPE**

Teachers and students most often have their own separate computers in a Study setup. However, in case of different configurations where Installation type allows you to define your system configuration in special cases where you either have student pairs sharing workstations or employ shared computing resources in the classroom.
Standard installation
This is the default option in which teachers and students all use their own computers.

Multistudent installation
Select this option if you have two students sharing student workstations.

Windows MultiPoint installation
Select this option if the system is installed onto a Windows MultiPoint setup where the teacher and students are connected to the same resource with thin clients.
STUDY SYSTEM LOGS

LOG FILE OPTIONS AND TUTOR LOG FILES

The System tab in Study Preferences allows you to access log files in which Sanako Study automatically makes a record of the activity in the system. You can choose whether to employ standard logging or extended logging, which creates more detailed log files.

There are also separate student log files recording the activity on each student computer. For instructions on how to access them, see below.

REMOVING STUDENT LOG FILES

To remove student log files, you need to access the Student settings window. Open the Tools menu, select Admin and
then **Student settings**.

1. In the **Student settings** window, select the **Temporary files** tab.
2. Check the student computers where you want to remove log files, or click [✓] to select all students.
3. Check the **Remove current log files** option
4. Click **Remove files**. The student log files are now deleted.

**COLLECTING STUDENT LOG FILES**

To collect student log files, you need to access the Student settings window. Open the **Tools** menu, select **Admin** and then **Student settings**.

1. In the **Student settings** window, select the **Log files** tab.
2. Check the student computers where you want to collect log files, or click [✓] to select all students.
3. Check the **Collect Tutor and client logs** option

4. Click **Collect log files**. The student log files are now collected to the location defined in Study Preferences.
VIEWING PRODUCT INFORMATION

Open the Tutor or Student Help menu and select About to open a window displaying product information, your software version, and the Study modules that you have installed.
SANAKO ADMIN TOOL

WHAT IS ADMIN TOOL?

Sanako Admin Tool is an additional module available for purchase that allows system administrators and IT staff to remotely monitor, control and perform maintenance tasks on Study classrooms and workstations. Admin Tool eliminates the need to physically visit each classroom for administrative and maintenance tasks.

Note: Admin Tool is installed with a separate installer found on both the Study download page and the product DVD. Admin Tool also requires a separate software token.

INSTALLATION OF ADMIN TOOL

Sanako Admin Tool software is available on the Study product DVD and the Study download site.

To install Admin Tool, run the StudyAdminSETUP.exe file found on the Study DVD and enter your Admin Tool software token information during installation.
Please note that the Admin Tool must be installed in the same subnet as the Study classrooms that will be monitored.

**USING ADMIN TOOL**

Admin Tool automatically locates all Study servers installed in the current subnet.

1. Select a server and click **Connect**.

![Screen shot showing the Admin Tool interface with a list of servers and a connect button highlighted.]

2. The classrooms and computers connected to the selected server are now displayed on the right.

![Screen shot showing a list of connected classrooms with their IP addresses and a button labeled 'Connected'.]

3. You can now select a computer and either **monitor** the computer screen or take **remote control**. You may also view multiple screens simultaneously in a **mosaic** window and **shut down** selected workstations.

![Screen shot showing a window with buttons labeled 'Monitor/Remote', 'Mosaic', and 'Shutdown'.]
SANAKO STUDY OFFLINE ACTIVATION

WHAT IS OFFLINE ACTIVATION?

Instead of a printed product license, Sanako Study customers receive a license activation token by email. The token is entered during Study Server software installation to activate the software license. However, the activation process requires that you have an active Internet connection.

In case the computer where you are installing Study Server software does not have an Internet connection, you may complete an offline activation process in order to finalize your installation.

Please note that part of the offline activation process needs to be performed on a computer with an Internet connection. This computer may be located anywhere.

WHAT IS REQUIRED FOR OFFLINE ACTIVATION?

- Sanako Study software
- USB flash drive
- Teacher/Server computer (offline)
- Computer with Internet connection (may be located anywhere)

HOW TO COMPLETE AN OFFLINE ACTIVATION

The offline activation process of a Study license has three parts.

- Software installation and creation of a license request file
- User account registration and creation of license activation file
• Activation of Study license token

SOFTWARE INSTALLATION AND CREATION OF A LICENSE REQUEST FILE

1. Start and proceed through Study software installation normally without entering a license token.

2. After installation, the Sanako License Manager opens. You can also open the Sanako License Manager manually (Start – All Programs – Sanako – Licenses)

3. Click Activate New

4. License Manager will inform you that the computer has no Internet connection available for license activation.

   ![Message]

   Click NO to initiate the offline activation process

5. The program will next ask you if you already have a ready license file.
At this point we do not have our license file yet, so click NO.

6. Enter your Sanako license token information and click OK.

7. The installation program will now ask you where to save a ‘license request file (.req)’. Enter your USB flash drive, click Save request and save the file onto the USB device.

We have now saved a ‘license request file (.req)’ onto a USB flash drive. Before the software can be used, you need to register a user account and acquire a ‘license activation file (.xml)’. The next part will explain how this is done.

USER ACCOUNT REGISTRATION AND CREATION OF LICENSE ACTIVATION FILE

Before the installed software can be used, you need to log on to the Sanako online registration site, create a user account and then use the ‘license request file (.req)’ to download a ‘license activation file (.xml)’.

8. Take the USB flash drive with the ‘license request file (.req)’ to any computer with an Internet connection

9. Open an Internet browser and go to the Sanako registration site at the following address http://registration.sanako.com/tokens
10. Click **Registration** to create a Sanako user account

If you already have an active user account, simply enter your details and skip items 11 and 12 in the instructions below.

11. Enter your information in the registration window and then click **Save**

12. You will receive your username and password to the email address provided during registration and a link to the login page of the Sanako registration site. Follow the link to the login page to confirm your registration and then log in to the Sanako registration site.
13. In the Sanako registration site, select the **Off-line activation** tab and click **Browse**.

14. Locate and select the *license request file (.req)* on the USB flash drive. The off-line activation tool will now download a *license activation file (.xml)*. Save the *license activation file (.xml)* onto the USB flash drive.

Next, you need to go back to the offline computer where the Sanako software has been installed and activate the license on the computer with the *license activation file (.xml)* on your USB device.

**ACTIVATION OF STUDY LICENSE TOKEN**

When you have downloaded a *license activation file (.xml)* onto your USB flash drive, the final part of the offline activation process is activating the license token on the offline computer.

15. Enter the USB flash drive onto the computer where Sanako software has been installed and open the **Sanako License Manager (Start – All Programs – Sanako – Licenses)**.
16. **Click Activate New**

17. The message informing you that the computer has no Internet connection appears again. Click **NO** to continue with offline activation.

18. The program will next ask you if you already have a ready license file.

   Click **YES** and then locate and select the ‘**license activation file (.xml)**’ on the USB flash drive.

19. You have now completed the offline license activation. Store your **installation ID number** for later use.
STANDALONE INSTALLATION FOR TRAINING

INSTALLING A TRAINING SYSTEM

You can install a standalone Study system for user practice. The training system will include the teacher application and three student applications on the same computer. Since all applications are on the same workstations, audio features are not operable, however, all other Study features are available.

Installing a training version of Study on a personal laptop or into a teachers’ lounge will allow teachers to get familiar with the software and try out selected features before using them in actual teaching. Teachers may sometimes be hesitant to use features they are not fully familiar with and may not have time to practice in the actual classroom.

The standalone installation is done with a separate installer on the Study product DVD and download site. Please note that a standalone training version of Study cannot be installed onto a computer that already has any of the Study software components (Server, Tutor or Student) installed.
INSTALLING FROM MSI PACKAGES

PRE-REQUISITES FOR MSI INSTALLATION

If you want to install Sanako Study using MSI packages, please check that the following requirements are met to ensure a successful installation.

Installing Study with MSI packages requires that Microsoft .NET Framework 4.0 or later have been installed onto the computer before installing any of the MSI packages. Please note that .NET 4.0 should be applied via Group Policy as there is no MSI package available from Microsoft.

Additionally, the following packages must also be installed onto the computer to ensure successful execution of the programs:

- mdxredist.msi – Installs DirectX managed extensions
- vcredist_x86.exe

The .exe Study installation package includes the above components. If the .exe Study installer is used, only .NET Framework needs to be installed beforehand.
INDEX

A

About Study 54
Activities
   selecting available 40
Adding tutors 32
Admin Tool 55
Audio device
   selection 25
   volume levels 26
   volume levels for Sanako headset 26
Audio files
   data properties 29
Audio hardware
   compatibility 25
Audio settings 25
   copying 27
   data properties of audio files 29
   hardware compatibility 25
   media player as source 28
   sound device selection 25
   volume levels 26
   volume levels for Sanako headset 26
Autoscan
   order 37
   step interval 37

B

Binding tokens 18
Blocking Internet 42

C

Class
   adding students 22
   default 22
   moving and arranging students 23
   removing students 24
Class files 32, 34
   creating new 35
   save location 35
Classroom 4
   changing 45
   classroom name 11, 14, 17
   selecting 21
   what is 4
Classroom name
   changing 47
   server 11

student 17
tutor 14
Components 3, 8
 order of installation 8
Computer
   identifying 44
Configuration
   adding tutors 32
   class files 32, 34
   folders 30
   tutor configuration files 32, 36
   tutor settings 36
Copying audio settings 27

D

Default class 22
Default folders 30
Directory structure 30
Disk space 7

F

File transfer
   copying or streaming 41
   local folders 41
Files
   copying or streaming 41
   data properties for audio files 29
   transfer from local folders 41
Firewall settings 7
Folders 30

G

General settings 39

H

Headset
   sanako headset audio levels 26

I

Identifying
   computers 44
   students 44
Installation 8
   binding tokens 18
   instructions 9
   msi packages 64
   order of components 8
   registering 18
   software components 8
   standalone system for training 63
Installation instructions 9
   server software 9
   student software 15
   tutor software 13
   Installation type 45, 49
Internet blocking 42

L
Language 37
License 4
licensing model 4
managing 45
offline activation 57
Log files 51, 52
options 51
student, collecting 52
student, removing 51
Tutor 51

M
Media player
tutor 40
Media player as source 28
Minimizing tutor screen 40
Monitor input line 40
MSI packages 64
installation 64
pre-requisites 64
Multicast 43
MultiPoint installation 50
Multistudent installation 50

N
Name
student 44
Network
directory structure 30
requirements 6

O
Offline activation 5n 57
Offline activation
activation of token 61
how to 57
installation and creation of request file 58
registration and creation of activation file 59
requirements 57
what is 57

P
Password
tutor 45, 48
Player
tutor 40
Product information 54

R
Registration 18
Removing students 24

Requirements 5
disk space 7
firewall 7
network 6
teacher and student computers 5

S
Screen transfer functions
disabling 43
Screen transfer settings 42
Server application 3
Server software
installation instructions 9
Settings
audio 25, 40
autoscan 37
class files 32, 34
classroom 45
default tutor player 40
disabling screen transfer 43
file transfer 41
folders 30
general 39
installation type 45, 49
internet 42
language 37
licenses 45
monitor input line 40
network connection type 43
password for Tutor 45
screen transfer 42
sound 25
streaming tutor and student media files 40
system configuration 45
text-to-speech 43
thumbnails 37, 43
tutor accounts 32
tutor specific 36
unicast, multicast 43
voice activity detection 40
Snapshot update interval 43
Sound device
selection 25
volume levels 26
volume levels for Sanako headset 26
Sound settings 25
Standalone installation 63
Starting Study 21
selecting tutor and classroom 21
Starting Study Student 24
Streaming tutor and student media files 40
Student application 3
starting 24
Student computer
identifying 44
Student software
installation instructions 15
Students
adding to class 22
default name 44
moving and arranging 23
removing 24
System components 3
System logs 51, 52

T
Text-to-Speech 43
Thumbnail update interval 43
Thumbnails
in separate window 37
size 37
Token
binding 18
Training
installation 63
Tutor
adding 32
disabling login 33
password 48
selecting 21
settings 36
Tutor application 3
Tutor Configuration Files 32, 36
Tutor login
disabling 33
Tutor player 40
Tutor settings 36
Tutor software
installation instructions 13
Tutoring
minimizing tutor screen 40

U
Unicast 43

V,W
Viewing product information 54
Wireless environments 43